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 1
I n t r o d u c t i o n
Welcome to the CAD Import Module! This User’s Guide details features and 
functionality available with the product. For example, you can read about how to 
import 3D CAD files, and how to use the automatic or interactive tools for repair 
and defeaturing to prepare your geometry for meshing.
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Abou t  t h i s  Gu i d e

This documentation covers the CAD Import Module and the add-on for file import of 
CATIA® V5 files.

About this Product

The CAD Import Module enables importing 3D designs from CAD files into your 
simulations.

The import capabilities cover the most common 3D CAD file formats: Parasolid®, ACIS®, 
AutoCAD®, IGES, STEP, SOLIDWORKS®, Inventor®, NX®, PTC® Creo® 
Parametric™, and PTC® Pro/ENGINEER®. In addition, support for CATIA® V5 is 
available as a separate add-on. To exchange data with CAD packages, you can export your 
geometry to the ACIS® or Parasolid® file formats.

Finally, the product provides a wide range of tools for you to prepare an imported 3D design 
for meshing and analysis. You can interactively search for and remove small features, for 
example, fillets, slivers, faces, and edges. You can also modify objects by detaching a portion 
to form an additional computational domain, or by creating a fluid domain for computation, 
in case the CAD design only includes the solid parts.

Where Do I Access the Documentation and Application Libraries?

A number of internet resources have more information about COMSOL, including licensing 
and technical information. The electronic documentation, topic-based (or context-based) 
help, and the application libraries are all accessed through the COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes all core physics interfaces and 
functionality included with the COMSOL Multiphysics license. This book also has 

If you are reading the documentation as a PDF file on your computer, the 
blue links do not work to open an application or content referenced in a 
different guide. However, if you are using the Help system in COMSOL 
Multiphysics, these links work to other modules (as long as you have a 
license), application examples, and documentation sets.
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instructions about how to use COMSOL Multiphysics and how to access the electronic 
Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to many of the features on the GUI. To learn 
more about a node in the Model Builder, or a window on the Desktop, click to highlight a 
node or window, then press F1 to open the Help window, which then displays information 
about that feature (or click a node in the Model Builder followed by the Help button ( ). 
This is called topic-based (or context) help.

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder click a node or 
window and then press F1. 

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help( ) 
button.

To open the Help window:

• In the Model Builder or Physics Builder click a node or window and then 
press F1.

• On the main toolbar, click the Help ( ) button.

• From the main menu, select Help>Help.
A B O U T  T H I S  G U I D E  |  7



Opening the Documentation Window

T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each application includes documentation with the theoretical background and step-by-step 
instructions to create a model application. The applications are available in COMSOL as 
MPH-files that you can open for further investigation. You can use the step-by-step 
instructions and the actual applications as a template for your own modeling and applications. 
In most models, SI units are used to describe the relevant properties, parameters, and 
dimensions in most examples, but other unit systems are available.

Once the Application Libraries window is opened, you can search by name or browse under 
a module folder name. Click to view a summary of the application and its properties, including 
options to open it or a PDF document. 

Opening the Application Libraries Window
To open the Application Libraries window ( ):

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu select Help>Documentation ( ).

To open the Documentation window:

• Press Ctrl+F1.

• On the main toolbar, click the Documentation ( ) button.

• From the main menu, select Help>Documentation.

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.

• From the Home toolbar, Windows menu, click ( ) Applications 

Libraries.

• From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help 
menu, select ( ) Update COMSOL Application Library.
8 |  C H A P T E R  1 :  I N T R O D U C T I O N



C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please contact your 
local COMSOL representative or send your questions to support@comsol.com. An automatic 
notification and case number is sent to you by email.

C O M S O L  W E B S I T E S

Select Application Libraries from the main File> or Windows> menus.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Library.

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

Support Center www.comsol.com/support

Product Download www.comsol.com/support/download

Product Updates www.comsol.com/support/updates

Discussion Forum www.comsol.com/community

Events www.comsol.com/events

COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase
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 2
C A D  I m p o r t ,  R e p a i r  a n d  D e f e a t u r i n g
This section describes the tools and geometry operations available for importing 
and modifying 3D CAD data in the CAD Import Module.

In this section:

• Functionality Overview

• Defeaturing Tools

• Geometry Operations
 11
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Fun c t i o n a l i t y  Ov e r v i ew

This section includes these topics:

• Available Geometry Operations

• Importing Files

• Defeaturing and Repair

• Creating CAD Objects

• Converting Objects to COMSOL Geometry Kernel Representation

• Converting Objects to Parasolid® Geometry Kernel Representation

• Exporting Objects to CAD Formats

Available Geometry Operations

The CAD Import Module provides a number of tools for importing objects from 3D 
CAD files, repairing them, and removing unnecessary details in them. There is also the 
possibility to draw objects represented using the Parasolid® geometry kernel, which is 
utilized by the Design Module, CAD Import Module, and all LiveLink™ products for 
CAD packages.

The geometry operations can only be applied on CAD objects — that is, geometry 
objects represented using the Parasolid geometry kernel. However, you can convert 
objects from the COMSOL kernel representation to CAD objects, for example by 
applying a Union or Convert to Solid operation on the object.

TABLE 2-1:  AVAILABLE GEOMETRY OPERATIONS

NAME DESCRIPTION

Cap Faces Add faces to fill holes or partition objects

Convert to COMSOL Convert to the COMSOL geometry kernel 
representation

Delete Faces Delete and replace faces

Delete Fillets Delete fillets

Delete Short Edges Delete short edges

Delete Sliver Faces Delete sliver faces

Delete Small Faces Delete small faces

Delete Spikes Delete spikes from faces
 2 :  C A D  I M P O R T ,  R E P A I R  A N D  D E F E A T U R I N G



Importing Files

Use the Import feature to import 3D CAD files. By default, small details and defects 
are automatically removed and the software tries to knit surface objects to form solids.

Defeaturing and Repair

To find and delete small details in the imported objects, use the defeaturing tools. 
These can also be used to delete or detach larger faces.

To more automatically remove small details and repair defects, use the Repair feature.

To knit surface objects to form solids, use the Knit to Solid feature.

Creating CAD Objects

By default, the software uses the geometry kernel of the CAD Import Module. This 
means that the geometry you draw is represented using the Parasolid kernel. If you 
would like to use the COMSOL kernel instead, you can click the Geometry node to 
open the Settings window. Change Geometry representation to COMSOL kernel.

The 3D operations and primitives listed in Table 2-2 do not support the geometry 
kernel of the CAD Import Module — they always use the COMSOL geometry kernel. 
However, an automatic conversion is performed for these primitives before they are 

Detach Faces Detach faces and form a new object from them

Import Import 3D CAD file

Knit to Solid Knit surface object to form solid or surface object

Repair Repair and removal of small details

TABLE 2-1:  AVAILABLE GEOMETRY OPERATIONS

NAME DESCRIPTION

To access these geometry operations, you need to use the CAD kernel for 
the geometry representation, which you can specify in the Preferences 
dialog box and in the Settings window for the Geometry node.
F U N C T I O N A L I T Y  O V E R V I E W  |  13
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used in Boolean operations, see Converting Objects to Parasolid® Geometry Kernel 
Representation. 

Converting Objects to COMSOL Geometry Kernel Representation

To convert CAD objects to objects represented using the COMSOL geometry kernel, 
use the Convert to COMSOL feature node.

Converting Objects to Parasolid® Geometry Kernel Representation

If the current geometry representation for the geometry sequence is CAD kernel, an 
automatic conversion of COMSOL objects to CAD objects takes place before using 
the objects in Boolean operations and before using the objects in the Convert to Solid, 

Convert to Surface, Convert to Curve, and Convert to Point operations. This ensures that 
the CAD kernel is used in the abovementioned operations.

An automatic conversion to CAD object is also performed before exporting geometry 
in the ACIS® and Parasolid® file formats.

TABLE 2-2:  3D OPERATIONS AND PRIMITIVES THAT DO NOT SUPPORT THE PARASOLID GEOMETRY KERNEL

FEATURE NAME

Bezier Polygon

Eccentric Cone

Extrude

Helix

Hexahedron

Interpolation Curve

Parametric Curve

Parametric Surface

Point

Polygon

Pyramid

Revolve

Sweep

Tetrahedron

Torus

Work Plane
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If the automatic conversion cannot be performed, the geometry operation is 
performed by the COMSOL geometry kernel. The conversion cannot be performed 
if there is an edge adjacent to three or more isolated faces, or if a face is bounded by 
an edge loop that intersects itself.

The automatic conversion to CAD representation is not performed if one of the input 
objects to the Boolean or conversion operation is the result of a previous Convert to 

COMSOL operation.

Exporting Objects to CAD Formats

The CAD Import Module, Design Module, and LiveLink™ products for CAD 
packages add ACIS and Parasolid to the list of supported formats for geometry export.

To export 3D geometry objects to these formats:

• right-click the Geometry node and select Export ( ), or 

• on the Geometry toolbar click Export ( ).

In the File type list, select Parasolid binary file, Parasolid text file, ACIS binary file, or ACIS 

text file. Use the Browse button to choose the filename, then click Save. Finally, click 
the Export button.

COMSOL objects are automatically converted to CAD objects before saving the file. 

The Parasolid binary and text formats do not allow coordinate values 
larger than 500. Therefore you might have to change the export unit in 
the Length unit list box to be able to export the geometry.

For details on which objects can be converted to CAD objects see 
Converting Objects to Parasolid® Geometry Kernel Representation.
F U N C T I O N A L I T Y  O V E R V I E W  |  15
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De f e a t u r i n g  T oo l s

This section describes the defeaturing tools for removing details from imported 3D 
CAD geometry. With the defeaturing tools you can delete both small details, such as 
short edges, small faces, sliver faces, and spikes, and larger details, for example, fillets, 
chamfers, and holes.

To access these features, from the Geometry toolbar, Defeaturing and Repair menu, 
select Delete Fillets, Delete Short Edges, Delete Sliver Faces, Delete Small Faces, Delete 

Spikes, Delete Faces, or Detach Faces from the submenu. You can also right-click the 
Geometry node and select the same options from the context menu.

When you are on a defeaturing page, you can switch to another defeaturing tool by 
clicking one of the corresponding buttons at the top of the page. Upon completion of 
the defeaturing operation a corresponding feature node, which you can modify, 
appears in the geometry sequence.

In this section:

• Finding and Deleting Small Details

• Delete Faces

• Detach Faces

Finding and Deleting Small Details

You can use any of the Delete Fillets ( ), Delete Short Edges ( ), Delete Sliver 

Faces ( ), Delete Small Faces ( ), and Delete Spikes ( ) tools to search for and 
delete details smaller than a given size. First activate the Input objects selection by 
clicking the Active button to toggle between  and . Select the objects you 
want to examine in the Graphics window. In the field Maximum fillet radius, Maximum 

edge length, Maximum face width, Maximum face size, or Maximum spike width, enter the 
maximum size of the details you want to delete. When you click the Find button, a list 
of details that are smaller than the given size are shown in the list below. To delete the 
found details, either click the Delete All button, or select a subset of the found details 
in the list and click Delete Selected. Then, the selected details are deleted from their 
objects, and a node corresponding to this operation is added to the geometry branch 
of the model tree.
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If you want to modify the performed deletion operation, you can select the added node 
in the geometry branch. Then, edit the node’s form that appears in the Settings 
window. Click the Build Selected button ( ) to see the result of your edits.

Delete Faces

The Delete Faces ( ) page is used to delete faces and replace them either with a new 
face (if Heal method is Fill) or a by growing or shrinking the adjacent faces (if Heal 

method is Patch). Select the faces you want to delete in the Graphics window. They 
appear in the Faces to delete list. Select the Heal as through hole check box if you have 
selected faces that make up a hole that you want to delete. When you click the Delete 

Selected button, the selected faces are deleted, and a node corresponding to this 
operation is added to the geometry branch of the model tree.

If you want to modify the performed deletion operation, you can select the added node 
in the geometry branch. Then, edit the node’s form that appears in the Settings 
window. Click the Build Selected button ( ) to see the result of your edits.

Detach Faces

The Detach Faces ( ) page is used to detach faces from a solid object (the parent) to 
form a new solid object (the child). Select the faces you want to detach in the Graphics 
window. They appear in the Faces to detach list.

The Parent heal method list determines how to replace the detached faces in the parent 
object: Fill means that a new face is constructed, and Patch means that the adjacent 
faces are grown or shrunk to heal the wound.

The Child heal method list controls how to construct the child solid from the detached 
faces: Fill means that a new face is formed based on the surrounding edges of each 
wound, Patch from child means that the detached faces grow or shrink to form a solid, 
and Patch from parent means that the parent faces surrounding the detached faces grow 
or shrink to form a solid together with the detached faces.

When you click the Detach Selected button, the program detaches the selected faces and 
adds a node corresponding to this operation to the geometry branch of the model tree. 
If you want to modify the performed detach operation, select the added node in the 
geometry branch. Then edit the node’s form that appears in the Settings window. Click 
the Build Selected button ( ) to see the result of your edits.
D E F E A T U R I N G  T O O L S  |  17
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Geome t r y  Ope r a t i o n s

In this section:

Cap Faces

You can add cap faces to fill holes in a geometry (for example, to make a domain for 
the void inside a cylinder geometry for simulating fluid flow inside the cylinder) or to 
partition the geometry. To add cap faces to objects, from the Geometry toolbar, 
Defeaturing and Repair menu, select Cap Faces ( ).

C A P  F A C E S

Select edges that form loops around the faces you want to create. The edges display in 
the Bounding edges list.

A cap face is created for each loop of edges in the input selection. The cap faces are 
joined with the original objects. If new closed volumes are created by the cap faces, 
these are converted to solid domains. The selected edges can contain more than one 
edge loop, but no two loops can have edges or vertices in common. The selected edges 
can contain edges from more than one object. In this case, each object is processed 
individually. This means that two edges or vertices can overlap as long as they are not 
in the same object. It also means that if new closed volumes are created, but bounded 
by faces from more than one object, these volumes are not converted to solid domains. 
If you want to perform a Cap Faces operation involving more than one object, first 
unite the objects using a Union operation.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 

• Cap Faces

• Convert to COMSOL

• Delete Faces

• Delete Fillets

• Delete Short Edges

• Delete Sliver Faces

• Delete Small Faces

• Delete Spikes

• Detach Faces

• Import
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• Repair
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contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Convert to COMSOL

To convert geometry objects represented using the Parasolid® geometry kernel, used 
by the CAD Import Module, to COMSOL geometry kernel representation, from the 
Geometry toolbar, Conversions menu, select Convert to COMSOL ( ).

C O N V E R T  T O  C O M S O L

Select the geometry objects that you want to convert in the Graphics window. The 
objects display in the Input objects list.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
G E O M E T R Y  O P E R A T I O N S  |  19



20 |  C H A P T E R
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Delete Faces

To delete and replace faces from an object, from the Geometry toolbar, CAD Defeaturing 
menu, select Delete Faces ( ). This opens the Delete Faces window. When the 
deletion operation has been performed, you can modify it by editing the 
corresponding Delete Faces node that appears in the geometry branch by clicking it.

D E L E T E  F A C E S

In the Faces to delete list, select the faces you want to delete. In the Heal method list, 
select the method to use for replacing the deleted faces: Fill means that the deleted faces 
are replaced with a new face, while Patch means that the adjacent faces are grown or 
shrunk to heal the wound. Select the Heal as through hole check box if you have selected 
faces that make up a hole that you want to delete.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

The Delete Faces tool can only be applied to objects that are represented 
by the Parasolid® geometry kernel, also called CAD objects.
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Delete Fillets

To delete fillets from an object, from the Geometry toolbar, Defeaturing and Repair 
menu, select Delete Fillets ( ). This opens the Delete Fillets window, see Finding and 
Deleting Small Details. When the deletion operation has been performed, you can 
modify it by editing the corresponding Delete Fillets node that appears in the 
geometry branch by clicking it.

Note that fillets found on nonmanifold objects are not possible to delete. An example 
of a nonmanifold object is an object with several domains. Such an object can for 
example result from a Union or a Partition operation. To remove the fillets make sure 
to defeature the geometry objects before applying Boolean operations that result in 
nonmanifold objects.

The Delete Fillets tool cannot delete fillets for which the adjacent faces cannot be 
extended to cover the gap. The figure below shows an example of such fillets. Applying 
the fillets on the highlighted edges deletes the annular face from the geometry, which 
cannot be recreated if the fillets are to be deleted.

D E L E T E  F I L L E T S

In the Input objects list, select the objects you want to delete fillets from. In the field 
Maximum fillet radius, enter the maximum size of the fillets you want to delete. When 
you click the Find Fillets button, a list of fillets with radius smaller that the given value 
is shown in the Fillet selection list. If Deletion type is All fillets, all such fillets are deleted. 
You can delete a subset of these fillets by clicking in the Fillet selection list, and choosing 
Selected fillets in the Deletion type list.

The Delete Fillets tool can only be applied to objects that are represented 
by the Parasolid® geometry kernel, also called CAD objects.
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S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Delete Short Edges

To delete short edges from an object, from the Geometry toolbar, Defeaturing and 

Repair menu, select Delete Short Edges ( ). This opens the Delete Short Edges window, 
see Finding and Deleting Small Details. When the deletion operation has been 
performed, you can modify it by editing the corresponding Delete Short Edges node 
that appears in the geometry branch by clicking it.

Note that this defeaturing tool cannot find short edges on nonmanifold objects. An 
example of a nonmanifold object is an object with several domains. Such an object can 
for example result from a Union or a Partition operation. To avoid this situation 
defeature the geometry objects before applying Boolean operations that result in 
nonmanifold objects.

D E L E T E  S H O R T  E D G E S

In the Input objects list, select the objects you want to delete short edges from. In the 
field Maximum edge length, enter the maximum length of the edges you want to delete. 
When you click the Find Short Edges button, a list of edges with length smaller that the 

The Delete Short Edges tool can only be applied to objects that are 
represented by the Parasolid® geometry kernel, also called CAD objects.
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given value is shown in the Short edge selection list. If Deletion type is All short edges, 
all such edges are deleted. You can delete a subset of these edges by clicking in the Short 

edge selection list, and choosing Selected short edges in the Deletion type list.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Delete Sliver Faces

To delete sliver faces from an object, from the Geometry toolbar, Defeaturing and Repair 
menu, select Delete Sliver Faces ( ). This opens the Delete Sliver Faces window, see 
Finding and Deleting Small Details. When the deletion operation has been performed, 
you can modify it by editing the corresponding Delete Sliver Faces node that appears 
in the geometry branch by clicking it.

Note that this defeaturing tool cannot find sliver faces on nonmanifold objects. An 
example of a nonmanifold object is an object with several domains. Such an object can 
for example result from a Union or a Partition operation. To avoid this situation 
defeature the geometry objects before applying Boolean operations that result in 
nonmanifold objects.

The Delete Sliver Faces tool can only be applied to objects that are 
represented by the Parasolid® geometry kernel, also called CAD objects.
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D E L E T E  S L I V E R  F A C E S

In the Input objects list, select the objects you want to delete sliver faces from. In the 
field Maximum face width, enter the maximum width of the faces you want to delete. 
When you click the Find Sliver Faces button, a list of faces with width smaller that the 
given value are shown in the Sliver faces selection list. If Deletion type is All sliver faces, 
all such faces are deleted. You can delete a subset of these faces by clicking in the Sliver 
face selection list, and choosing Selected sliver faces in the Deletion type list.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Delete Small Faces

To delete small faces from an object, from the Geometry toolbar, Defeaturing and Repair 
menu, select Delete Small Faces ( ). This opens the Delete Small Faces window, see 
Finding and Deleting Small Details. When the deletion operation has been performed, 
you can modify it by editing the corresponding Delete Small Faces node that appears 
in the geometry branch by clicking it.

Note that this defeaturing tool cannot find small faces on nonmanifold objects. An 
example of a nonmanifold object is an object with several domains. Such an object can 

The Delete Small Faces tool can only be applied to objects that are 
represented by the Parasolid® geometry kernel, also called CAD objects.
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for example result from a Union or a Partition operation. To avoid this situation 
defeature the geometry objects before applying Boolean operations that result in 
nonmanifold objects.

D E L E T E  S M A L L  F A C E S

In the Input objects list, select the objects you want to delete small faces from. In the 
field Maximum face size, enter the maximum diameter of the faces you want to delete. 
When you click the Find Small Faces button, a list of faces with diameter smaller that 
the given value appears in the Small faces selection list. If Deletion type is All small faces, 
all such faces are deleted. You can delete a subset of these faces by clicking in the Small 

face selection list, and choosing Selected small faces in the Deletion type list.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Delete Spikes

A spike is a long and narrow protrusion on an edge or corner of a face defined by two 
or three edges. To delete spikes from an object, from the Geometry toolbar, Defeaturing 

and Repair menu, select Delete Spikes ( ). This opens the Delete Spikes window, see 
Finding and Deleting Small Details. When the deletion operation has been performed, 
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you can modify it by editing the corresponding Delete Spikes node that appears in the 
geometry branch by clicking it.

Note that this defeaturing tool cannot find spikes on faces that belong to nonmanifold 
objects. An example of a nonmanifold object is an object with several domains. Such 
an object can for example result from a Union or a Partition operation. To avoid this 
situation defeature the geometry objects before applying Boolean operations that 
result in nonmanifold objects.

D E L E T E  S P I K E S

In the Input objects list, select the objects you want to delete spikes from. In the field 
Maximum spike width, enter the maximum width of the spikes you want to delete. 
When you click the Find Spikes button, a list of spikes with width smaller that the given 
value are shown in the Spike selection list. If Deletion type is All spikes, all such spikes 
are deleted. You can delete a subset of these spikes by clicking in the Spike selection list, 
and choosing Selected spikes in the Deletion type list.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

The Delete Spikes tool can only be applied to objects that are represented 
by the Parasolid® geometry kernel, also called CAD objects.
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Detach Faces

To detach faces from an object (the parent) and form a new object (the child), from 
the Geometry toolbar, Defeaturing and Repair menu, select Detach Faces. This opens the 
Detach Faces window. When the detach operation has been performed, you can 
modify it by editing the corresponding Detach Faces node that appears in the geometry 
branch by clicking it.

D E T A C H  F A C E S

Select the faces you want to detach in the Graphics window. They appear in the Faces 
to detach list.

The Parent heal method list determines how to replace the detached faces in the parent 
object: Fill means that a new face is constructed, and Patch means that the adjacent 
faces grow or shrink to heal the wound.

The Child heal method list controls how to construct the child solid from the detached 
faces: Fill means that a new face is formed based on the surrounding edges of each 
wound, Patch from child means that the detached faces are grown or shrunk to form a 
solid, and Patch from parent means that the parent faces surrounding the detached 
faces are grown or shrunk to form a solid together with the detached faces.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 

The Detach Faces tool can only be applied to objects that are represented 
by the Parasolid® geometry kernel, also called CAD objects.
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use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.

Import

To import geometry objects from a 3D CAD file, from the Home or the Geometry 
toolbar, click Import ( ). In the Import section of the Settings window, select 3D CAD 

file from the Geometry import list. You can also skip this step as the type of the selected 
file is automatically recognized by the code. Click Browse to locate the file to import, 
or enter the path to the file. Before clicking the Import button consider to review and 
configure the import settings. If you have changed some settings after importing a file, 
the file is automatically re-imported when you click a build button.

The imported geometry objects are represented in the Parasolid® geometry kernel, 
which is used by the CAD Import Module, Design Module, and LiveLink products 
interfacing CAD packages.

Some 3D CAD formats use periodic parametrization for edges and faces. For example, 
a full-revolution cylindrical edge or face appears seamless in the CAD program. During 
import edges or faces that have a periodic parameterization are cut in two halves by 
inserting new vertices and edges. This is done because the mesh algorithms do not 
support periodic entities. You can ignore such inserted edges using an Ignore Edges 
feature from Virtual Operations.

S U P P O R T E D  F O R M A T S

The CAD import supports the following 3D CAD formats: 

TABLE 2-3:  SUPPORTED 3D CAD FILE FORMATS

FILE FORMAT NOTES FILE EXTENSIONS SUPPORTED VERSIONS

ACIS® 1, .sat, .sab up to 2018 1.0

AutoCAD® 1, 2 .dwg, .dxf 2.5-2019

CATIA® V5 2, 3 .CATPart, 
.CATProduct

R8 to R2018

PTC® Creo® Parametric™ 1 .prt, .asm 1.0-5.0

IGES 1 .igs, .iges up to 5.3

Inventor® assembly 1, 2 .iam 11, 2008-2017

Inventor® part 1, 2 .ipt 6 to 11, 
2008-2019

NX® 1, 4 .prt up to 12
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Note 1: This format requires a license for one of the CAD Import Module, or Design 
Module, or LiveLink product for a CAD package.

Note 2: Available only on a supported Windows operating system.

Note 3: This format requires, in addition to the CAD Import Module, or Design 
Module, or a LiveLink product for a CAD package, a license for the File Import for 
CATIA V5 module.

Note 4: Support for the NX® file format is available only on a supported Windows or 
Linux operating system.

Note 5: Embedded parts in assemblies are not supported. To import such an assembly, 
first convert the embedded parts to external parts.

L E N G T H  U N I T

In the Length unit list, select From CAD document to change the geometry’s length unit 
to the unit in the file (if the file has a length unit). Select From COMSOL to keep the 
geometry’s length unit and scale the objects in the file to the geometry’s unit.

O B J E C T S  T O  I M P O R T

Select the types of objects to import using the Solids, Surfaces, and Curves and points 
check boxes.

If the Surfaces check box is selected, you can choose how COMSOL imports the 
surfaces using the list under For surface objects:

• Choose Form solids (the default) to knit together surface objects to form solids.

• Choose Knit surfaces to form surface objects by knitting.

• Choose Do not knit to not form any surface or solid objects from the imported 
surfaces.

For the Form Solids and Knit surfaces options select the Fill holes check box to generate 
new faces to replace missing geometry.

Parasolid® 1 .x_t, .x_b up to V31.0

PTC® Pro/ENGINEER® 1 .prt, .asm 16 to Wildfire 5

SOLIDWORKS® 1, 2, 5 .sldprt, .sldasm 98-2018

STEP 1 .step, .stp AP203E1, AP214

TABLE 2-3:  SUPPORTED 3D CAD FILE FORMATS

FILE FORMAT NOTES FILE EXTENSIONS SUPPORTED VERSIONS
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If the Curves and points check box is selected, the Unite curve objects check box is 
selected by default to unite the imported curve objects, which speeds up the rendering 
of the geometry.

I M P O R T  O P T I O N S

The Absolute import tolerance is a length measured in the geometry’s unit after the 
import. When importing 3D CAD files, the program merges geometric entities with a 
distance smaller that this tolerance.

If you select the Check imported objects for errors check box, a warning appears if the 
imported objects contain errors.

If you select the Repair imported objects check box, the software tries to repair defects 
and remove details smaller than the Absolute import tolerance.

If you select the Remove redundant edges and vertices check box, the software tries to 
remove redundant edges and vertices.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the objects consist of 
available as selections in all applicable selection lists (in physics and materials settings, 
for example), choose an option from the Show in physics list: All levels, Domain selection, 
Boundary selection, Edge selection, or Point selection. The default is Domain selection, 
which is suitable for use with materials and physics defined in domains. For use with a 
boundary condition, for example, choose Boundary selection. These selections do not 
appear as separate selection nodes in the model tree. Select Off to not make any 
selection available outside of the geometry sequence.

Select the Individual objects selections check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence for each individual object in the geometry 
file and for each relevant entity level. To also make all or one of the types of resulting 
entities (domains, boundaries, edges, and points) that the objects consist of available 
 2 :  C A D  I M P O R T ,  R E P A I R  A N D  D E F E A T U R I N G



as selections in all applicable selection lists (in physics and materials settings, for 
example), choose an option from the Show in physics list: All levels, Domain selection, 
Boundary selection, Edge selection, or Point selection. The default is Domain selection, if 
available, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence

Knit to Solid

To knit surface objects to form solid objects, from the Geometry toolbar, Defeaturing 

and Repair menu, select Knit to Solid ( ).

K N I T  T O  S O L I D

Select the objects to knit together in the Graphics window. They appear in the Input 

objects list. 

The knitting merges edges that have a distance smaller that the Absolute repair 

tolerance and deletes gaps and spikes smaller than the Absolute repair tolerance. If the 
Fill holes check box is selected the operation attempts to generate new faces to replace 
missing geometry.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.
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Repair

To repair objects, from the Geometry toolbar, Defeaturing and Repair menu, select 
Repair ( ).

R E P A I R

Select the objects to repair in the Graphics window. They appear in the Input objects list. 

The software tries to repair defects and remove details smaller than the Absolute import 

tolerance. More precisely:

• Entities with invalid sense

• Invalid edge and vertex tolerances

• Invalid manifolds

• Self-intersecting manifolds

• Non-G1 manifolds

• Missing edge or vertex manifolds

• Missing vertex

• Vertices not on curve of edge

• Edges and vertices not on surface of face

• Removal of surface self-intersections that lie outside the face

• Splitting at edge intersections which have no vertex

• Removal of discontinuities by either splitting or smoothing

• Remove small features (short edges, small faces, sliver faces, and spikes)

Select the option Simplify curves and surfaces to also simplify the underlying curve and 
surface manifolds of the geometric entities. Repairing objects with this option may 
help in some cases when Boolean operations on the objects fail.

S E L E C T I O N S  O F  R E S U L T I N G  E N T I T I E S

If you want to make the resulting entities contribute to a cumulative selection, select 
a cumulative selection from the Contribute to list (the default, None, gives no 
contribution), or click the New button to create a new cumulative selection (see 
Cumulative Selections in the COMSOL Multiphysics Reference Manual).

Select the Resulting objects selection check box to create predefined selections (for all 
levels — objects, domains, boundaries, edges, and points — that are applicable) in 
subsequent nodes in the geometry sequence. To also make all or one of the types of 
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resulting entities (domains, boundaries, edges, and points) that the resulting objects 
consist of available as selections in all applicable selection lists (in physics and materials 
settings, for example), choose an option from the Show in physics list: All levels, Domain 

selection, Boundary selection, Edge selection, or Point selection. The default is Domain 

selection, which is suitable for use with materials and physics defined in domains. For 
use with a boundary condition, for example, choose Boundary selection. These 
selections do not appear as separate selection nodes in the model tree. Select Off to not 
make any selection available outside of the geometry sequence.
G E O M E T R Y  O P E R A T I O N S  |  33



34 |  C H A P T E R
  2 :  C A D  I M P O R T ,  R E P A I R  A N D  D E F E A T U R I N G



 3
P r o g r a m m i n g  a n d  C o m m a n d  R e f e r e n c e
In this section you find detailed COMSOL® API reference information for the 
geometry features in the CAD Import Module.

In this section:

• Defeaturing Tools

• Summary of Commands

• Commands Grouped by Function
 35
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De f e a t u r i n g  T oo l s

To remove unnecessary details in objects imported from a 3D CAD file, you can use 
the defeaturing tools. You access these by typing:

model.component(<ctag>).geom(<tag>).defeaturing("Fillets");
model.component(<ctag>).geom(<tag>).defeaturing("ShortEdges");
model.component(<ctag>).geom(<tag>).defeaturing("SliverFaces");
model.component(<ctag>).geom(<tag>).defeaturing("SmallFaces");
model.component(<ctag>).geom(<tag>).defeaturing("Spikes");
model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces");
model.component(<ctag>).geom(<tag>).defeaturing("DetachFaces");

Using the defeaturing tools you can search for small details, without altering your 
geometry. If you find small details that you want to remove, a defeaturing tool can 
create a feature that removes the details from the geometry.

The features corresponding to the defeaturing tools are DeleteFillets, 
DeleteShortEdges, DeleteSliverFaces, DeleteSmallFaces, DeleteSpikes, 
DeleteFaces, and DetachFaces. If you already know which details you need to 
remove, it is also possible to create these features directly using the standard create 
syntax.

This section includes these topics:

• Defeaturing Tools — Finding and Deleting Small Details

• Defeaturing Tools — Delete Faces

• Defeaturing Tools — Detach Faces

Defeaturing Tools — Finding and Deleting Small Details

The defeaturing tools Fillets, ShortEdges, SliverFaces, SmallFaces, and 
Spikes search for and delete details smaller than a given size. First select the objects 
you want to examine by typing, for example, 

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
      selection("input").set(<onames>);

where <onames> is a string array contains the object names.

Set the maximum size of the details (fillets in this case) you want to remove by typing

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
set("entsize",size);
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To find the details that are smaller than the given size, type

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
find();

The found details appear in the selection

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
detail();

To get the number of found details, type

int nd = model.component(<ctag>).geom(<tag>).
defeaturing("Fillets").detail().size();

To get the names of the found details, type

String[] filletNames = model.component(<ctag>).geom(<tag>).
defeaturing("Fillets").detail().groupNames();

In general, a detail (fillet in this case) consists of a number of geometric entities. For 
example, a fillet consists of a number of faces. To get the entity numbers in the nth 
detail, type

int[] entities = model.component(<ctag>).geom(<tag>).
 defeaturing("Fillets").detail().groupEntities(n);

To get the object that contains the nth detail, type

String oname = model.component(<ctag>).geom(<tag>).
defeaturing("Fillets").detail().groupObject(n);

To delete all details found, type

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
deleteAll(<ftag>);

This adds a feature, tagged <ftag>, that performs the deletion operation to the 
geometry sequence, after the current feature, and build this feature. In this case, it adds 
a DeleteFillets feature.

To delete a subset of the details found, type, for example

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
detail().setGroup(2,5);

to delete fillets number 2 and 5. You can also use, for example, 

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
detail().addGroup(7,8);

model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
detail().removeGroup(3);

to add and remove details from the selection. Perform the deletion by typing
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model.component(<ctag>).geom(<tag>).defeaturing("Fillets").
delete(<ftag>);

This adds a DeleteFillets feature tagged <ftag> after the current feature in the 
geometry sequence.

D E F E A T U R I N G  M E T H O D S

model.component(<ctag>).geom(<tag>).feature(<ftag>).find() searches for 
small details, for a defeaturing feature <ftag>.

model.component(<ctag>).geom(<tag>).defeaturing(tooltag).find() 
searches for small details, for a defeaturing tool tooltag.

model.component(<ctag>).geom(<tag>).defeaturing(tooltag).detail().

selMethod manipulates the selection of details to remove, for a defeaturing tool 
tooltag.

model.component(<ctag>).geom(<tag>).feature(<ftag>).detail().

selMethod manipulates the selection of details to remove, for a defeaturing feature 
<ftag>.

model.component(<ctag>).geom(<tag>).defeaturing(tooltag).

delete(<ftag>) creates a defeaturing feature of type tooltag, tagged <ftag>, with 
the properties currently specified in the defeaturing tool. The property delete of the 
created feature is set to selected. If the feature <ftag> can be built, it is inserted in 
the geometry sequence after the current feature, otherwise the feature is discarded.

model.component(<ctag>).geom(<tag>).defeaturing(tooltag).

deleteAll(<ftag>) creates a defeaturing feature of type tooltag, tagged <ftag>, 
with the properties currently specified in the defeaturing tool. The property delete of 
the created feature is set to all. If the feature <ftag> can be built, it is inserted in the 
geometry sequence after the current feature, otherwise the feature is discarded.

D E F E A T U R I N G  S E L E C T I O N  M E T H O D S

For a defeaturing selection sel the following methods are available, in addition to the 
methods available for a general geometry selection. 

Geometry Object Selection Methods in the COMSOL Multiphysics 
Programming Reference Manual
 3 :  P R O G R A M M I N G  A N D  C O M M A N D  R E F E R E N C E



The find method on the corresponding feature or defeaturing tool provides the 
defeaturing selection with a list of details. Each detail is a group of geometric entities. 
Group numbers, <groups>, is an array of integers that index into the list of details. 

You can select groups either by explicitly referring to group numbers, or by selecting 
geometric entities. In the latter case, any group that has non-empty intersection with 
the provided entity selection is selected.

int[] sel.group(<groups>) returns the group numbers for the selected groups.

sel.addGroup(<groups>) adds the specified groups to the selection.

sel.setGroup(<groups>) sets the selection groups.

sel.removeGroup(<groups>) removes the specified groups from the selection.

String[] sel.groupNames() returns a list of names of the groups found.

String sel.groupObject(<group>) returns the name of the geometry object that 
contains the specified detail group.

int[] sel.groupEntities(<group>) returns the entity numbers of the specified 
detail group.

int sel.size() returns the number of detail groups found.

Defeaturing Tools — Delete Faces

Use the DeleteFaces tool to delete faces and replace them either with a new face or 
by growing or shrinking the adjacent faces. Select the faces to delete and properties for 
the operation like in the corresponding feature DeleteFaces. The deletion is 
performed when you issue the command

model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces").
delete(<ftag>);

This adds a DeleteFaces feature tagged <ftag> after the current feature in the 
geometry sequence.

Defeaturing Tools — Detach Faces

Use the DetachFaces tool to detach faces from a solid object (the parent) to form a 
new solid object (the child). Select the faces to detach and properties for the operation 
like in the corresponding feature DetachFaces. The detach operation is performed 
when you issue the command
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model.component(<ctag>).geom(<tag>).defeaturing("DetachFaces").
delete(<ftag>);
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S umma r y  o f  C ommand s

These commands are included in this section:

• CapFaces

• ConvertToCOMSOL

• DeleteFaces

• DeleteFillets

• DeleteShortEdges

• DeleteSliverFaces

• DeleteSmallFaces

• DeleteSpikes

• DetachFaces

• Import

• Knit

• Repair
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Command s  G r oup ed b y  Fun c t i o n

Commands for Defeaturing

Commands for File Import, Conversion and Repair

Commands for Geometry Creation and Modification

FUNCTION PURPOSE

DeleteFaces Delete faces from CAD objects and heal the 
wounds

DeleteFillets Find and delete fillets in CAD objects

DeleteShortEdges Find and delete short edges in CAD objects

DeleteSliverFaces Find and delete sliver faces in CAD objects

DeleteSmallFaces Find and delete small faces in CAD objects

DeleteSpikes Find and delete spikes in CAD objects

DetachFaces Detach faces from CAD objects to form a new 
solid

FUNCTION PURPOSE

ConvertToCOMSOL Convert CAD Import Module geometry objects to 
COMSOL objects

Import Import geometry objects from a 3D CAD file

Knit Knit surface CAD objects to form solids or surface 
objects

Repair Repair CAD objects

FUNCTION PURPOSE

CapFaces Add cap faces to fill holes in CAD geometries
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Command s  i n  A l p h ab e t i c a l  O r d e r

CapFaces

P U R P O S E

Add cap faces to objects.

S Y N T A X

model.component(<ctag>).geom(<tag>).feature().
create(<ftag>,"CapFaces");

model.component(<ctag>).geom(<tag>).feature(<ftag>).
selection(property);

D E S C R I P T I O N

model.component(<ctag>).geom(<tag>).feature().
create(<ftag>,"CapFaces")

creates a CapFaces feature. A cap face is created for each loop of edges in the input 
selection. The cap faces are joined with the original objects. If new domains are created 
by the cap faces, these domains are made solid.

The input selection can contain more than one edge loop, but no two loops can have 
edges or vertices in common.

The input selection can contain edges from more than one object. In this case, each 
object is processed individually.

TABLE 3-1:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

input Selection The input edges.

selresult on | off off Create selections of all 
resulting objects.

selresultshow all | obj | 
dom | bnd | 
edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, 
and so on, or in part 
instances. obj is not available 
in a component’s geometry. 
dom, bnd, and edg are not 
available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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ConvertToCOMSOL

Convert CAD Import Module geometry objects to COMSOL objects.

S Y N T A X

model.component(<ctag>).geom(<tag>).feature().
create(<ftag>,"ConvertToCOMSOL");

model.component(<ctag>).geom(<tag>).feature(<ftag>).
selection(property);

D E S C R I P T I O N

model.component(<ctag>).geom(<tag>).feature().
create(<ftag>,"ConvertToCOMSOL")

creates a ConvertToCOMSOL feature.

S E E  A L S O

Import

DeleteFaces

Delete faces from CAD objects and heal the wounds.

TABLE 3-2:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

input Selection Names of input objects.

selresult on | off off Create selections of all 
resulting objects.

selresultshow all | obj | 
dom | bnd | 
edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, 
and so on, or in part 
instances. obj is not available 
in a component’s geometry. 
dom, bnd, and edg are not 
available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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S Y N T A X

model.component(<ctag>).geom(<tag>).feature().
create(<ftag>,"DeleteFaces");

model.component(<ctag>).geom(<tag>).feature(<ftag>).
selection(property);

model.component(<ctag>).geom(<tag>).feature(<ftag>).
set(property,<value>);

model.component(<ctag>).geom(<tag>).feature(<ftag>).
getType(property);

model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces").
selection(property)

model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces").
      set(property,<value>);
model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces").dele

te(<ftag>);

D E S C R I P T I O N

model.component(<ctag>).geom(<tag>).defeaturing("DeleteFaces").

delete(<ftag>) creates a DeleteFaces feature tagged <ftag> with the specified 
properties. If the feature can be built, it is inserted in the geometry sequence after the 
current feature; otherwise, the feature is discarded.

It is also possible to create a DeleteFaces feature using the standard create method.

The faces in the property input are deleted from their objects. The resulting object is 
healed so that a solid object is obtained. If heal is fill, a new face is formed based on 

TABLE 3-3:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

input Selection Faces to delete.

heal fill | patch patch Healing method.

throughhole on | off off Heal as if the removed faces are a 
through hole.

selresult on | off off Create selections of all resulting 
objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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the surrounding edges of each wound. If heal is patch, the surrounding faces of each 
wound are grown or shrunk to heal the wound.

When you delete through holes, set the throughhole property to on to indicate that 
the two wounds from where the hole entered and exited the geometry are to be healed 
independently instead of as a single wound. If throughhole is off, the wound would 
be healed with a single new face that would just recreate the hole.

E X A M P L E

The following example imports the file defeaturing_demo_2.mphbin, and removes 
a hole from the geometry model.

Model model = ModelUtil.create("Model1");
model.component.create("comp1");
model.component("comp1").geom().create("geom1",3);
model.component("comp1").geom("geom1").feature().

create("imp1","Import");
model.component("comp1").geom("geom1").feature("imp1").

set("filename","defeaturing_demo_2.mphbin");
model.component("comp1").geom("geom1").run("imp1");
model.component("comp1").geom("geom1").feature().

create("dfa1","DeleteFaces");
model.component("comp1").geom("geom1").feature("dfa1").

selection("input").set("imp1",6,7,8,9,11,12,13);
model.component("comp1").geom("geom1").run();

C O M P A T I B I L I T Y

The following property is no longer supported:

S E E  A L S O

DeleteFillets, DeleteSliverFaces, DeleteSmallFaces, DetachFaces

DeleteFillets

Find and delete fillets in CAD objects.

TABLE 3-4:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables
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S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"DeleteFillets");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).find();
model.geom(<tag>).feature(<ftag>).detail();

model.geom(<tag>).defeaturing("Fillets").selection(property);
model.geom(<tag>).defeaturing("Fillets").set(property,<value>);
model.geom(<tag>).defeaturing("Fillets").find();
model.geom(<tag>).defeaturing("Fillets").detail();
model.geom(<tag>).defeaturing("Fillets").delete(<ftag>);
model.geom(<tag>).defeaturing("Fillets").deleteAll(<ftag>);

D E S C R I P T I O N

model.geom(<tag>).defeaturing("Fillets").delete(<ftag>) creates a 
DeleteFillets feature tagged <ftag> with the specified properties. The property 
delete is set to selected. If the feature can be built, it is inserted in the geometry 
sequence after the current feature; otherwise, the feature is discarded.

model.geom(<tag>).defeaturing("Fillets").deleteAll(<ftag>) works as 
the delete method, but the property delete is set to all.

It is also possible to create the DeleteFillets feature using the standard create 
method. The following properties are available..

TABLE 3-5:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

delete all | selected selected Delete all fillets of given size, or 
a selection. Only available for 
the feature.

entsize double 1e-3 Maximum fillet radius.

input Selection Names of input objects.

selresult on | off off Create selections of all resulting 
objects.
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model.geom(<tag>).feature(<ftag>).find() searches the input objects for fillets 
with radius less than entsize.

model.geom(<tag>).feature(<ftag>).detail() returns a selection object where 
you can select a subset of the fillets found.

The find and detail methods of model.geom(<tag>).defeaturing("Fillets") 
has the corresponding functionality for the defeaturing tool.

Only faces that can be deleted without invalidating the object are deleted. If a fillet was 
not possible to delete, a warning is given, accessible through 
model.geom(<tag>).feature(<ftag>).problem().

C O M P A T I B I L I T Y

The following property is no longer supported:

E X A M P L E

The following example imports the CAD object in the COMSOL Multiphysics 
geometry file defeaturing_demo_3.mphbin and finds all fillets with radius less than 
4·10−3. The first of these fillets is deleted.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
      "defeaturing_demo_3.mphbin");
model.geom("geom1").run("imp1");
model.geom("geom1").feature().create("dfi1","DeleteFillets");
model.geom("geom1").feature("dfi1").selection("input").

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj 
is not available in a component’s 
geometry. dom, bnd, and edg 
are not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.

TABLE 3-6:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables

TABLE 3-5:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION
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      set("imp1");
model.geom("geom1").feature("dfi1").set("entsize",4e-3);
model.geom("geom1").feature("dfi1").find();
model.geom("geom1").feature("dfi1").detail().setGroup(1);
model.geom("geom1").run();

S E E  A L S O

DeleteFaces

DeleteShortEdges

Find and delete short edges in CAD objects.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"DeleteShortEdges");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).find();
model.geom(<tag>).feature(<ftag>).detail();

model.geom(<tag>).defeaturing("ShortEdges").selection(property);
model.geom(<tag>).defeaturing("ShortEdges").
      set(property,<value>);
model.geom(<tag>).defeaturing("ShortEdges").find();
model.geom(<tag>).defeaturing("ShortEdges").detail();
model.geom(<tag>).defeaturing("ShortEdges").delete(<ftag>);
model.geom(<tag>).defeaturing("ShortEdges").deleteAll(<ftag>);

D E S C R I P T I O N

model.geom(<tag>).defeaturing("ShortEdges").delete(<ftag>) creates a 
DeleteShortEdges feature tagged <ftag> with the specified properties. The 
property delete is set to selected. If the feature can be built, it is inserted in the 
geometry sequence after the current feature; otherwise, the feature is discarded.

model.geom(<tag>).defeaturing("ShortEdges").deleteAll(<ftag>) works 
as the delete method, but the property delete is set to all.
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It is also possible to create a DeleteShortEdges feature using the standard create 
method. The following properties are available.

model.geom(<tag>).feature(<ftag>).find() searches the input objects for 
edges of length less than entsize.

model.geom(<tag>).feature(<ftag>).detail() returns a selection object where 
you can select a subset of the edge sets found.

The find and detail methods of 
model.geom(<tag>).defeaturing("ShortEdges") has the corresponding 
functionality for the defeaturing tool.

Only edges that can be deleted without invalidating the object are deleted. If an edge 
was not possible to delete, a warning is given, accessible through 
model.geom(<tag>).feature(<ftag>).problem().

C O M P A T I B I L I T Y

The lengths of the edges are no longer returned.

TABLE 3-7:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

delete all | selected selected Delete all edges of given size, or 
a selection. Only available for the 
feature.

entsize double 1e-3 Maximum edge length

input Selection Names of input objects

selresult on | off off Create selections of all resulting 
objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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The following property is no longer supported:

E X A M P L E

The following example imports the file defeaturing_demo_4.x_b and finds all edges 
with length less than 3·10−3. The first of these edges is deleted.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
     "defeaturing_demo_4.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().
      create("dse1","DeleteShortEdges");
model.geom("geom1").feature("dse1").selection("input").
      set("imp1");
model.geom("geom1").feature("dse1").set("entsize",3e-3);
model.geom("geom1").feature("dse1").find();
model.geom("geom1").feature("dse1").detail().setGroup(1);
model.geom("geom1").runAll();

DeleteSliverFaces

Find and delete sliver faces in CAD objects.

S Y N T A X

model.geom(gname).feature().create(<ftag>,"DeleteSliverFaces");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).find();
model.geom(<tag>).feature(<ftag>).detail();

model.geom(<tag>).defeaturing("SliverFaces").selection(property);
model.geom(<tag>).defeaturing("SliverFaces").
      set(property,<value>);
model.geom(<tag>).defeaturing("SliverFaces").find();
model.geom(<tag>).defeaturing("SliverFaces").detail();
model.geom(<tag>).defeaturing("SliverFaces").delete(<ftag>);
model.geom(<tag>).defeaturing("SliverFaces").deleteAll(<ftag>);

TABLE 3-8:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables
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D E S C R I P T I O N

model.geom(<tag>).defeaturing("SliverFaces").delete(<ftag>) creates a 
DeleteSliverFaces feature tagged <ftag> with the specified properties. The 
property delete is set to selected. If the feature can be built, it is inserted in the 
geometry sequence after the current feature; otherwise, the feature is discarded.

model.geom(<tag>).defeaturing("SliverFaces").deleteAll(<ftag>) works 
as the delete method, but the property delete is set to all.

It is also possible to create a DeleteSliverFaces feature using the standard create 
method. The following properties are available.

Sliver faces are narrow but long faces with large aspect ratio, which usually give rise to 
extremely fine local meshes in their vicinity.

model.geom(<tag>).feature(<ftag>).find() searches the input objects for faces 
with width less than entsize.

model.geom(<tag>).feature(<ftag>).detail() returns a selection object where 
you can select a subset of the faces found.

The find and detail methods of 
model.geom(<tag>).defeaturing("SliverFaces") has the corresponding 
functionality for the defeaturing tool.

TABLE 3-9:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

delete all | selected selected Delete all sliver faces of given 
width, or a selection. Only 
available for the feature.

entsize double 1e-3 Maximum face width.

input Selection Names of input objects.

selresult on | off off Create selections of all resulting 
objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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Only faces that can be deleted without invalidating the object are deleted. If a face was 
not possible to delete, a warning message is given.

C O M P A T I B I L I T Y

The following property is no longer supported:

E X A M P L E

The following example imports the geometry model from the file 
defeaturing_demo_5.x_b, finds sliver faces narrower than 2·10−3, and deletes the 
first of these.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
     "defeaturing_demo_5.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("dsl1","DeleteSliverFaces");
model.geom("geom1").feature("dsl1").selection("input").
set("imp1");
model.geom("geom1").feature("dsl1").set("entsize",2e-3);
model.geom("geom1").feature("dsl1").find();
model.geom("geom1").feature("dsl1").detail().setGroup(1);
model.geom("geom1").runAll();

S E E  A L S O

DeleteFaces, DeleteSmallFaces

DeleteSmallFaces

Find and delete small faces in CAD objects.

TABLE 3-10:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx | status

none Output variables
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S Y N T A X

model.geom(gname).feature().create(<ftag>,"DeleteSmallFaces");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).find();
model.geom(<tag>).feature(<ftag>).detail();

model.geom(<tag>).defeaturing("SmallFaces").selection(property);
model.geom(<tag>).defeaturing("SmallFaces").set(property,<value>);
model.geom(<tag>).defeaturing("SmallFaces").find();
model.geom(<tag>).defeaturing("SmallFaces").detail();
model.geom(<tag>).defeaturing("SmallFaces").delete(<ftag>);
model.geom(<tag>).defeaturing("SmallFaces").deleteAll(<ftag>);

D E S C R I P T I O N

model.geom(<tag>).defeaturing("SmallFaces").delete(<ftag>) creates a 
DeleteSmallFaces feature tagged <ftag> with the specified properties. The 
property delete is set to selected. If the feature can be built, it is inserted in the 
geometry sequence after the current feature; otherwise, the feature is discarded. 

model.geom(<tag>).defeaturing("SmallFaces").deleteAll(<ftag>) works 
as the delete method, but the property delete is set to all.

It is also possible to create a DeleteSmallFaces feature using the standard create 
method. The following properties are available.

TABLE 3-11:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

delete all | selected selected Delete all small faces of given 
size, or a selection. Only 
available for the feature.

entsize double 1e-3 Maximum face size.

input Selection Names of input objects.

selresult on | off off Create selections of all resulting 
objects.
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A small face is a face that fits within a sphere of specified radius, given in the property 
entsize.

model.geom(<tag>).feature(<ftag>).find() searches the input objects for faces 
with size less than entsize.

model.geom(<tag>).feature(<ftag>).detail() returns a selection object where 
you can select a subset of the faces found.

The find and detail methods of 
model.geom(<tag>).defeaturing("SmallFaces") has the corresponding 
functionality for the defeaturing tool.

Only faces that can be deleted without invalidating the object are deleted. If a face was 
not possible to delete, a warning message is given, accessible through 
model.geom(<tag>).feature(<ftag>).problem().

C O M P A T I B I L I T Y

The following property is no longer supported:

E X A M P L E

The following example imports the geometry model from the file 
defeaturing_demo_6.x_b, finds sliver faces narrower than 10−3, and deletes the first 
of these.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.

TABLE 3-12:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx | status

none Output variables.

TABLE 3-11:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION
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model.geom("geom1").feature("imp1").set("filename",
     "defeaturing_demo_6.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("df1","DeleteSmallFaces");
model.geom("geom1").feature("df1").selection("input").
      set("imp1");
model.geom("geom1").feature("df1").find();
model.geom("geom1").feature("df1").detail().setGroup(1);
model.geom("geom1").run();

S E E  A L S O

DeleteFaces, DeleteSliverFaces

DeleteSpikes

Find and delete spikes in CAD objects.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"DeleteSpikes");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).find();
model.geom(<tag>).feature(<ftag>).detail();

model.geom(<tag>).defeaturing("Spikes").selection(property);
model.geom(<tag>).defeaturing("Spikes").set(property,<value>);
model.geom(<tag>).defeaturing("Spikes").find();
model.geom(<tag>).defeaturing("Spikes").detail();
model.geom(<tag>).defeaturing("Spikes").delete(<ftag>);
model.geom(<tag>).defeaturing("Spikes").deleteAll(<ftag>);

D E S C R I P T I O N

model.geom(<tag>).defeaturing("DeleteSpikes").delete(<ftag>) creates a 
DeleteSpikes feature tagged <ftag> with the specified properties. The property 
delete is set to selected. If the feature can be built, it is inserted in the geometry 
sequence after the current feature; otherwise, the feature is discarded.

model.geom(<tag>).defeaturing("DeleteSpikes").deleteAll(<ftag>) 
works as the delete method, but the property delete is set to all.
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It is also possible to create a DeleteSpikes feature using the standard create 
method. The following properties are available.

A spike is a long and narrow protrusion on an edge or corner of a face defined by two 
or three edges.

model.geom(<tag>).feature(<ftag>).find() searches the input objects for 
spikes of width less than entsize.

model.geom(<tag>).feature(<ftag>).detail() returns a selection object where 
you can select a subset of the spikes found.

The find and detail methods of model.geom(<tag>).defeaturing("Spikes") has 
the corresponding functionality for the defeaturing tool.

Only spikes that can be deleted without invalidating the object are deleted. If a spike 
was not possible to delete, a warning message is given, accessible through 
model.geom(<tag>).feature(<ftag>).problem().

C O M P A T I B I L I T Y

The width of each spike is no longer returned.

TABLE 3-13:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

delete all | selected selected Delete all spikes of given width, 
or a selection. Only available for 
the feature.

entsize double 1e-3 Maximum spike width.

input Selection Names of input objects.

selresult on | off off Create selections of all resulting 
objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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The following property is no longer supported:

E X A M P L E

The following example imports the geometry model from the file 
defeaturing_demo_7.x_b, finds all spikes narrower than 10−4, and deletes the first 
of these.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
     "defeaturing_demo_7.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("dsp1","DeleteSpikes");
model.geom("geom1").feature("dsp1").selection("input").
      set("imp1");
model.geom("geom1").feature("dsp1").set("entsize",1e-4);
model.geom("geom1").feature("dsp1").find();
model.geom("geom1").feature("dsp1").detail().setGroup(1);
model.geom("geom1").runAll();

S E E  A L S O

DeleteShortEdges, DeleteSliverFaces

DetachFaces

Detach faces from CAD objects to form a new (child) solid.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"DetachFaces");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);

model.geom(<tag>).defeaturing("DetachFaces").selection(property);
model.geom(<tag>).defeaturing("DetachFaces").set(property,<value>);
model.geom(<tag>).defeaturing("DetachFaces").delete(<ftag>);

TABLE 3-14:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx | status

none Output variables.
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D E S C R I P T I O N

model.geom(<tag>).defeaturing("DetachFaces").delete(<ftag>) creates a 
DetachFaces feature tagged <ftag> with the specified properties. If the feature can 
be built, it is inserted in the geometry sequence after the current feature; otherwise, 
the feature is discarded.

It is also possible to create a DetachFaces feature using the standard create method.

The faces in the property input are detached from their parent object. A new solid, 
the child object, are formed from the detached faces. The output objects are the healed 
parent and child objects. 

The property healparent determines how the parent object is healed to form a new 
solid after detaching the faces. The value fill means that a new face is formed based 
on the surrounding edges of each wound. The value patch means that the 
surrounding faces of each wound are grown or shrunk.

The property healchild determines how the child solid is constructed from the 
detached faces. The value fill means that a new face is formed based on the 
surrounding edges of each wound. The value patchchild means that the detached 
faces are grown or shrunk to form a solid. The value patchparent means that the 

TABLE 3-15:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

input Selection Faces to detach.

healchild fill | 
patchchild | 
patchparent

patchparent Healing method used on the 
child object.

healparent fill | patch patch Healing method used on the 
parent object.

selresult on | off off Create selections of all 
resulting objects.

selresultshow all | obj | dom 
| bnd | edg | 
pnt | off

dom Show selections of resulting 
objects in physics, materials, 
and so on, or in part 
instances. obj is not available 
in a component’s geometry. 
dom, bnd, and edg are not 
available in all features.

contributeto String none Tag of cumulative selection 
to contribute to.
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parent faces surrounding the detached faces are grown or shrunk to form a solid 
together with the detached faces.

E X A M P L E

The following example imports the COMSOL Multiphysics geometry file 
defeaturing_demo_2.mphbin and detaches a hole defined by a set of faces:

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
     "defeaturing_demo_2.mphbin");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("det1","DetachFaces");
model.geom("geom1").feature("det1").selection("input").
      set("imp1",6,7,8,9,11,12,13);
model.geom("geom1").runAll();

C O M P A T I B I L I T Y

The following property is no longer supported:

S E E  A L S O

DeleteFaces

Import

Import geometry objects from a 3D CAD file using the CAD Import Module or a 
LiveLink product for CAD software.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"Import");
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property);
model.geom(<tag>).feature(<ftag>).importData();

TABLE 3-16:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables
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D E S C R I P T I O N

model.geom(<tag>).feature().create(<ftag>,"Import") creates an import 
feature. When the property filename is set to a filename recognized as a 3D CAD file, 
the property type is set to cad. The following properties are available.

TABLE 3-17:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

check on | off Check imported objects for 
errors.

filename String Filename.

fillholes on | off off Attempt to generate new faces 
to replace missing geometry if 
the property knit is solid or 
surface

importtol double 1e-5 Absolute repair tolerance.

keepbnd on | off on Import surface objects.

keepfree on | off off Import curve and point objects.

keepsolid on | off on Import solid objects.

knit solid | surface | 
off

solid Knit together surface objects to 
form solids or surface objects.

removeredundant on | off off Remove redundant edges and 
vertices.

repair on | off on Repair imported objects.

type cad Type of import.

unit source | current source Take length unit from file or 
from the current geometry 
unit.

unitecurves on | off on Unite curve objects.

selresult on | off off Create selections of all 
resulting objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, 
and so on, or in part instances. 
obj is not available in a 
component’s geometry. dom, 
bnd, and edg are not available 
in all features.

contributeto String none Tag of cumulative selection to 
contribute to.
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The file to import is specified by filename, which can have of any of the following 
formats:

Note 1: This format requires a license for the CAD Import Module, Design Module, 
or a LiveLink product for a CAD package.

Note 2: This format requires, in addition to the CAD Import Module, Design 
Module, or a LiveLink product for a CAD package, a license for the File Import for 
CATIA V5 module.

Note 3: Only supported on Windows.

The imported geometry objects are represented using the Parasolid geometry kernel, 
which is the geometry kernel utilized by the CAD Import Module and the LiveLink 
products for CAD software.

The method

model.geom(gname).feature(<ftag>).importData()

imports the file again, even if the feature is built.

C O M P A T I B I L I T Y

The following property is no longer supported:

TABLE 3-18:  SUPPORTED 3D CAD FILE FORMATS

FILE FORMAT NOTE FILE EXTENSION

Autodesk Inventor 1, 3 .ipt, .iam

CATIA V5 2, 3 .CATPart, .CATProduct

IGES 1 .igs, .iges

Parasolid 1 .x_t, .x_b

PTC Pro/ENGINEER 1 .prt, .asm

SAT (ACIS) 1 .sat, .sab

SOLIDWORKS 1, 3 .sldprt, .sldasm

STEP 1 .step, .stp

TABLE 3-19:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

coercion solid | face | 
off

solid Alias for knit. face is equivalent 
to surface.
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Knit

Knit surface CAD objects to form solids or surface objects.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"Knit");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property)

D E S C R I P T I O N

model.geom(<ftag>).feature().create(<ftag>,"Knit") creates a knit feature 
tagged <ftag>. The following properties are available.

This function also removes gaps and spikes that are within the absolute tolerance 
specified in the property repairtol.

C O M P A T I B I L I T Y

The following property is no longer supported:

TABLE 3-20:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

fillholes on | off off Attempt to generate new faces 
to replace missing geometry

input Selection Names of input surface objects.

repairtol double 1e-5 Absolute repair tolerance.

selresult on | off off Create selections of all resulting 
objects.

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

contributeto String none Tag of cumulative selection to 
contribute to.

TABLE 3-21:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables.
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E X A M P L E

The following example imports the file repair_demo_2.x_b, and knits the surface 
objects into a solid. A gap is also removed during the operation.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
                                        "repair_demo_2.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("knit1","Knit");
model.geom("geom1").feature("knit1").selection("input").
                                     set("imp1");
model.geom("geom1").feature("knit1").set("repairtol",1e-3);
model.geom("geom1").runAll();

S E E  A L S O

Repair

Repair

Repair CAD objects.

S Y N T A X

model.geom(<tag>).feature().create(<ftag>,"Repair");
model.geom(<tag>).feature(<ftag>).selection(property);
model.geom(<tag>).feature(<ftag>).set(property,<value>);
model.geom(<tag>).feature(<ftag>).getType(property)

D E S C R I P T I O N

model.geom(<tag>).feature().create(<ftag>,"Repair") creates a repair 
feature tagged <ftag>. The following properties are available.

TABLE 3-22:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

input Selection Names of input surface objects

repairtol double 1e-5 Absolute repair tolerance

selresult on | off off Create selections of all resulting 
objects.
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The function tries to remove or repair the following defects:

• Entities with invalid sense

• Invalid edge and vertex tolerances

• Invalid manifolds

• Self-intersecting manifolds

• Non-G1 manifolds

• Missing edge or vertex manifolds

• Missing vertex

• Vertices not on curve of edge

• Edges and vertices not on surface of face

• Removal of surface self-intersections that lie outside the face

• Splitting at edge intersections which have no vertex

• Removal of discontinuities by either splitting or smoothing

• Remove small features (short edges, small faces, sliver faces, and spikes)

C O M P A T I B I L I T Y

The following property is no longer supported:

selresultshow all | obj | dom | 
bnd | edg | pnt | 
off

dom Show selections of resulting 
objects in physics, materials, and 
so on, or in part instances. obj is 
not available in a component’s 
geometry. dom, bnd, and edg are 
not available in all features.

simplify on | off off Simplify the underlying curve and 
surface manifolds of geometric 
entities

contributeto String none Tag of cumulative selection to 
contribute to.

TABLE 3-23:  OBSOLETE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION

Out stx | ftx | ctx | 
ptx

none Output variables

TABLE 3-22:  AVAILABLE PROPERTIES

PROPERTY VALUE DEFAULT DESCRIPTION
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E X A M P L E

The following example imports the file repair_demo_2.x_b, and repairs the resulting 
objects.

Model model = ModelUtil.create("Model1");
model.geom().create("geom1",3);
model.geom("geom1").feature().create("imp1","Import");
model.geom("geom1").feature("imp1").set("filename",
                                        "repair_demo_2.x_b");
model.geom("geom1").runAll();
model.geom("geom1").feature().create("rep1","Repair");
model.geom("geom1").feature("rep1").selection("input").
                                    set("imp1");
model.geom("geom1").feature("rep1").set("repairtol",1e-3);
model.geom("geom1").runAll();

S E E  A L S O

Knit
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